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The Control Technology Center (CTC) is happy to provide the
document and disks, "CAT (Controlling Air Toxics) Version 1.0."
It is the result of a joint project between the CTC and the New
Jersey Department of Environmental Protection (NJDEP).
Instructions for installation of the program are in the tutorial
manual. Common problems to be aware of are listed in a read.me
file included with the program. After the program is installed,
you can view this file by typing on your computer keyboard, "type
read.me."” The program is not copy-protected and may be copied.
However, it is advantageous to register your use with the CTC so
that you will receive future updates.

The CTC was established by the EPA Office of Research and
Development (ORD) and Office of Air Quality Planning and
Standards (OBRQPS) to provide technical assistance to State and
Local Air Pollution Control Agencies and the EPA Regional Offices.
The CTC's assistance is available ONLY to State and Local Agency
and Regional Office personnel, and provides control technology
assistance for all air pollutants and control activities. If you
have a need for control technology assistance or questions: about
the CTC, please call the HOTLINE at (919)541-0800 or FTS
629-0800. The enclosures further describe the CTC and its
projects. '

The program, CAT, is a computerized aid for State and Local
air agency and Regional Office personnel who review air emission
permit applications. The program is designed to eliminate the
need to perform complex calculations by hand. The engineering
software, CAT, is based on the EPA document, Control Technologies
for Hazardous Air Pollutants, EPA/625/6-86/014, September, 1986.
This document has been used extensively by State and Local
personnel with favorable results. In talking to the users and
examining the document, it became evident that the material in the
document would be even more useful on a computer, eliminating the
necessity of repetitively performing complex calculations.

The permit reviewer inputs information on the air emission
stream characteristics as well as other information provided in
the permit application. The program allows the permit reviewer
to select a specific pollutant/control device for evaluation.

The program then calculates design parameters and estimates costs
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for each control technology selected. The results can be
compared against the applicant's actual or proposed design. The
software is designed to easily allow what-if type calculations,
allowing the reviewer to change one or more parameters and
recalculate the results. A report generator is included in the
program.

Work is already underway on a second version of this
program. In this second version, a screening version of the
program will be included to assist the permit reviewer in
determining which permits are most deserving of a more thorough
review. We are also interested in hearing your comments on any
problems you may have and how the program can be improved. Send
any comments on problems or improvements to Carlos Nunez at MD-61
at the above address. Please include your name and phone number
so he can contact you if he has questions about your comments.

If additional copies of CAT are needed for State and Local
Agency or Regional Office personnel, if you did not receive your
copy through the CTC and would like to register your use for
future updates, or if you have comments for version 2, you may
contact Beth Crabtree at (919)541-4005 or FTS 629-4005 or MD-61 at
the above address. Copies of the document and disks will also be
available soon through the National Technical Information Service
(NTIS).

Sincerely yours,

S H

Sharon L. Nolen
Control Technology Center
Air Toxics Research Division

Attachments (3)
Control Technology Center - Update
Control Technology Center Project Update
Tutorial Manual for CAT (Controlling Air Toxics) with
Diskettes 1 and 2
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PREFACE

The CAT program was funded as a cooperative project by EPA's Control Technology Center (CTC)
and the New Jersey Department of Environmental Protection (NJDEP).

The CTC was established by EPA’s Oflice of Research and Development (ORD) and Office of Air
Quality Planning and Standards (OAQPS) to provide technical assistance to State and Local air pollution
control agencies. Three levels of assistance can be accessed through the CTC. First. a CTC HOTLINE has
been established to provide telephone assistance on matters relating to air pollution control technology.
Second, more in-depth engineering assistance can be provided when appropriate. Third, the CTC can
provide technical guidance through publication of technical guidance documents. development of

personal computer software, and presentation of workshops on control technology matters.

The technical guidance projects, such as this one, focus on topics of national or regional interest
that are identifled through contact with State and Local agencies. In this case, the CTC became
interested in automating the calculations from the ORD document, Control Technologies for Hazardous
Alr Pollutants, EPA/625/6-86-014, September 1986. The document discusses choosing the appropriate
control technology for vapor and particulate emissions streams and leads the reader. step-by-step,

through the calculations required for design and cost estimations of 10 different control devices.

Soon after the CTC decided to fund a project to computerize the document, it was discovered that
the NJDEP had plans to develop a similar system to help automate the permit review process for the State
of New Jersey. CTC and NJDEP agreed to work together to produce a computer program to assist permit
reviewers across the country in the review of air emission permit applications. This document is the

tutorial manual for the program resulting from the joint effort.

it



EPA REVIEW NOTICE
This report has been reviewed by the U. S. Environmental Protection Agency, and approved for publication.
Approval does not signify that the contents necessarily reflect the views and policy of the Agency, nor does

mention of trade names or commercial products constitute endorsement or recommendation for use.

This document is available te the public through the National-Techmeal Information-Service, Spnngfield,
Virginia 22161.
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Tutorial Manual for CAT, Version 1.0 August, 1988

SECTION 1
INTRODUCTION

This document is a tutorial manual for the program, Controlling Air Toxics (CAT). The purpose of the
program is to assist permit engineers in the review of permit applications for control of air toxics. The
program performs design and cost calculations for the control device based on the emission stream

charactenstics.

This manual describes how to operate the software on a personal computer, the commands used, and how
to enter and receive information. Examples are included with the software, and one 1s used 1n this tutorial.
The manual also contains several appendices to aid in using the program, including data input forms
which may be used as work sheets.

The CAT program is based on the EPA Handbook, Control Technologies for Hazardous Air Pollutants,
EPA/625/6-86/014, and is meant to be used with the handbook. If you intend to use CAT to review permit
applications, you should acquire a copy of this handbook. More up-to-date costs have been used when

available and are explained in Appendix A.
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SECTION 2
INSTALLATION

This secuon tells you how to install CAT on your IBM®personal computer or clone. CAT requires a hard
disk with one megabyte of available space, 640K of memory, and DOS 2.0 or higher.

Furst, insert your CAT distribution disk 1 into the A: drive and type
A:INSTALL

Next, insert CAT distributon disk 2 when prompted. This procedure will create a directory C:\CAT and
place a copy of the CAT program and 1ts data files there.

An example for each control device is included in the files provided with CAT. The example files are:

File Name Control Device
AB.CAT Absorber

CA.CAT Carbon Adsorber
CL.CAT Catalytic Incinerator
CO.CAT Condenser

FF.CAT Fabric Filter
FL.CAT Flare

TI.CAT Thermal Incinerator
VS.CAT Venturi Scrubber
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SECTION 3
OPERATION

To run the program, change directories to the CAT directory:

CD \CAT

then invoke the program by typing:

CAT

August,

1988

A few moments will pass while the program loads a number of files from the disk, then the title page will
appear (see Figure 1). Use [PgUp], [PgDn], [Home], and [End] keys to view the preface material. Use
the [Esc] key to begin using the program.

(

Press PgUp, PgDn, Home, and End to scroll, Esc when finished

CAT

(Controlling Air Toxics)

Sharon Nolen Tom Micar
Control Technology Center New Jersey Department of
U.S Environmental Protection Agency Environmental Protection

Developed by Radian Corporation

The purpose of this program 1s to assist permit engineers 1n the review
of permit applications for control of air toxics The program performs
design and cost calculations for the control device based on the
emission stream characteristics. The program 1s based on the EPA

Figure 1. The Title Page for CAT.



Tutorial Manual for CAT, Version 1.0 August, 1988

THE MAIN MENU

CAT uses a menu styled after Lotus® which permanently appears at the top of the computer screen.

Figure 2 presents the main menu which now appears at the top of your screen. To use the menus, you may
use the arrow keys on the cursor pad at the right of your keyboard to highlight a desired menu option and
press [Enter] or simply press the first character of the option. This will either elicit some action from the
program or produce another menu of options (a sub-menu). Selection is made from the sub-menu as

before; to exit the sub-menu and return to the parent menu, press the [Esc] key.

Note: The options on each menu are placed generally in the order, left to right, that will be most useful to

the permut reviewer who is entering data.

-5 A

Plant Strean Device Review File Clear Quit
Enter 1dentifying data far the plant.

Figure 2. The CAT Main Menu.
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This tutorial uses an example file called TL.CAT, which is loaded by using the File menu (see page 25).

The other example files are discussed on page 2. For now, to load the file:

Press F for File, then press R for Recall.

Now, enter TI.CAT and press [Enter] to load the file and return to the main menu.

PLANT

Now, press P from the main menu to run the Plant activity.

Figure 3 shows the form which will be displayed on your screen. You fill out the form by placing data in
each field. A field is the highlighted area which contains the blinking cursor. To enter data in a field, just
type using the keyboard. You may move between fields by using the arrow keys and [Home] and [End].
Some of the function keys on the keyboard may be used to help in this task; refer to Data Entry Control
Keys, Section 4.

Plant Stream Device Review File Clear Quit
Enter 1dent1fying data for the plant

= Plant Identifywng Data
Company Glaze Chemical Company

Street 87 Octane Drive
City Somewhere
State,ZIP NJ, 12345-0001

Contact John Leake
Telephone (999) 123-4567 Ext.
Reviewer

Figure 3. The Plant Form.
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The information on this plant form will be printed out on any reports you print from this file. It is not

required for calculations, but will be useful in future review of the reports generated.

When you strike the [Enter] key from the last field, CAT will ask if you are ready to leave the form.
Answer Y to go back to the main menu or N 1If you want to continue working on the form. You may skip
directly to this question from any other field on the Plant form by pressing the [F10] key. If you have
made changes to the Plant form and wish to abandon them, press the [Esc] key from anywhere inside the

form.

You will encounter other forms in the CAT program. A form will always be surrounded by a double line
box with a description in the upper left-hand comer of the box. [F10] will always exit the form, keeping
any changes you may have made.

Now, press the [F10] key and then press Y to confirm and return to the main menu.

STREAM

Now, press S from the main menu to invoke the Stream menu.

You will see a sub-menu with four options; Type, Parameters, HAP, and Clear, as shown at the top of
Figure 4. The Stream activity prompts you to characterize an emission stream by entering its type, its
physical parameters, and the pollutants it contains.

STREAM/TYPE

Now, press T to specify the Type of emission stream.

You must categorize the emission stream before you can proceed further. As you become more

experienced with the program, you will find that your choice of stream type will influence which device

types you may choose from the Device menu and the questions you are required to answer.
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You will now see a pop-up menu on the left side of the display (see Figure 4). This pop-up menu is similar
to other pop-up menus in the CAT program in its appearance and manipulation. A pop-up menu will
always be surrounded by a single-line box. The box may or may not have a title on its top line; this one
does not. You will also see a question or prompt displayed on the third line of the display which tells you
what informauion CAT is trying to elicit from you. To make a selection from the pop-up menu, use the
cursor keys to highlight the option you desire and press [Enter]. In some pop-up menus this will cause a

form to pop up; here, it does not. You may always leave a pop-up menu without selecung anything by
pressing [Esc].

( “
Type Parameters HAP Clear

Select the type of the emission stream.
What type of emission stream are you evaluating?

organic vapor
1norganic vapor
organic particulate
inorganic particulate

Figure 4. Stream Types.

Now, select the organic vapor stream type and press [Enter].

Note: Once a stream type has been selected, it can be changed by choosing the Type option again and
selecting another type. If, however, you have already filled out other stream information and then select a
new stream type, the other information you have filled in will be lost. This is unavoidable, since different
information is required by the different stream types.
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STREAM/PARAMETERS

Now, press P for Parameters.

Figure 5 shows what your display will look like. This is a pop-up menu of parameters which contains four
entries for each menu option. The first column shows what the parameter is. The name is right-justified
on the display and the next three columns contain the Applicant's value, the Calculation value, and
Checked, yes or no - more about these in a moment.

4 A
Type Parameters HAP Clear
Enter parameters describing the emission stream

Select a parameter and press Enter, or Esc to exit.

r Parameter Appl Calc - Checked
Maximum flow rate (scfm) 15000
Pressure (mmHg)
Temperature (degF) 120
Heat content (Btu/scf) .4
Oxygen content (%) 20.6
Moisture content (%) -2
Relative humidity (%)
Are halogenated organics present? (Y/N) N

Are metals present? (Y/N)

Figure 5. Characterizing the Emission Stream.

To input or change the values on the display, choose a parameter from the pop-up menu by highlighting
the parameter and pressing [Enter).



Tutorial Manual for CAT, Version 1.0 August, 1988

Now, select the Maximum flow rate from the menu and press [Enter] .

Your display should appear as in Figure 6. Selecting a parameter will cause a parameter form to pop up in
the center of your screen which has fields for each of the three columns on the menu line, plusa
Recommended value field. The name of the form is the name of the associated variable from the HAP
manual. This will help you backtrack CAT computations if you wish. The first line of the form contains a
full description of the parameter. The Recommended value field may contain some default value to be
used for the calculation value if none is available from the applicant. In general, you should always try to
obtain all information from the applicant, but this 1s not always possible. CAT will recommend default
values for some of the more difficult-to-find values. You can never enter a value into the Recommended
value field.

( A

Type Parameters HAP Clear
Enter parameters describing the emission stream
Select a parameter and press Enter, or Esc to exit.

- Parameter Appl Calc - Checked;
Maxwnum flow rate (scfm) 15000
Pressure (mmHg)

= Qe
Maximum flow rate (scfm)

Applicant value
Recommended value

Calculation value 15000

Checked

Figure 6. Changing a Parameter Value.
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You will be prompted to fill out three fields on the parameter form; The Applicant value, the Calculation
value, and Checked. These fields will help you to track your progress in reviewing the application. They
will be especially useful if your review takes more than one session with the CAT program or if your
agency runs quality control checks on your review.

The Applicant value is the value reported by the applicant on the permit application. This field is stored

strictly for comparison purposes; it will never be used in any computation.

The Calculaton value field should contain the value you wish to be used to compute design parameters for
a device. Normally this value should be the same as the Applicant value. This will not be true if the
applicant did not supply a value, or if you wish to study the effect of changing the value on the design.
Some calculation values will be computed by CAT; you will not be able to change the calculation value
for these "Evaluation" parameters.

The Checked field is supplied to allow you to annotate which parameters you have reviewed and agree
with. This field should also be used if the applicant value is non-blank and you use some other value for

the calculation value. Entera Y in this field if you agree with the applicant's value.

As with other forms, you may discard your changes by pressing [Esc]. In the parameter forms, press
[Esc) before entering a value 1n the Checked field.

Now, press [Esc] 1o return to the Parameter menu, then press [Esc] again 1o return to the Stream menu.

STREAM/HAP

Now, press H to invoke the HAP sub-menu.

The HAP sub-menu activity is designed to help you to specify which hazardous air pollutants (HAPs) exist

in the emission stream and to specify the physical parameters for each. There are four options under this

sub-menu, as shown in Figure 7.

10
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STREAM/HAP/GENERATE

Now, press G for Generate.

CAT contains a data base that identifies which pollutants may be associated with different Standard
Industrial Classification (SIC) codes. Figure 7 presents the pop-up menu of SIC codes obtained by running
the Generate option. Try the [Home] and [End] keys and note that they will take you to the start and end
of the pop-up menu.

[ A
Generate Review Add Delete

Generate a list of candidate HAPs from the SIC code.

Select the SIC code and press Enter or Esc to abort

2591 DRAPERY HARDWARE & BLINDS & SHADES
2599 FURNITURE AND FIXTURES, NEC

2611 PULP MILLS

2621 PAPER MILLS. EXCEPT BUILDING PAPER
2631 PAPERBOARD MILLS

2641 PAPER COATING AND GLAZING

2643 BAGS, EXCEPT TEXTILE BAGS

2644 CONVERTED PAPER AND PAPERBOARD PRODUCTS
2645 DIE-CUT PAPER AND BOARD

2647 SANITARY PAPER PRODUCTS

2648 STATIONERY PRODUCTS

2649 CONVERTED PAPER PRODUCTS, NEC

2651 FOLDING PAPERBOARD BOXES

2653 CORRUGATED AND SOLID FIBER BOXES
2654 SANITARY FOOD CONTAINERS

2655 FIBER CANS, DRUMS & SIMILAR PRODUCTS
2661 BUILDING PAPER AND BOARD MILLS

2700 PRINTING AND PUBLISHING

2711 NEWSPAPERS

Figure 7. Selecting Pollutants Based on SIC Code.

Now, use the [UpArrow] and [DnArrow] keys 1o select 2641 PAPER COATING AND GLAZING, and
press [Enter].

11
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After a moment, CAT will display a list of pollutants and CAS numbers (see Figure 8). Asof now, CAT

believes that these are the pollutants contained in the emission stream. This display is also a pop-up menu;

to edit the parameters for any pollutant, highlight the pollutant using the cursor mouon keys and press

[Enter).
- )
Generate Review Add Delete
Generate a l1st of candidate HAPs from the SIC code
67-64-1 ACETONE
7664-41-7 AMMONIA
78-93-3 BUTANONE,2-
630-08-0 CARBON MONOXIDE
64-17-5 ETHANOL
50-00-0 FORMALDEHYDE
7783-06-4 HYDROGEN SULFIDE
78-83-1 1SOBUTYL ALCOHOL
67-63-0 ISOPROPANOL
67-56-1 METHANOL
127-18-4 TETRACHLOROETHYLENE
108-88-3 TOLUENE
71-55-6 TRICHLOROETHANE,1,1,1-
N\ J

Figure 8. Possible Pollutants from SIC Code 2641.

Now, select the pollutant TOLUENE and press [Enter].

12
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A parameter pop-up menu for TOLUENE overlays the pollutant pop-up menu (see Figure 9). This pop-up
menu shows physical parameters for TOLUENE, with all available parameters filled out from the data
base.

4 N\
Generate Review Add Delete
Review the HAPs 1n the emission stream.
Select TOLUENE parameter and press Enter, or Esc to exit
r Parameter Appl Calc - Checkedh
Inlet HAP concentration (ppmv) 73
Molecular weight (1b/1b-mole) 92 15
Specific heat equation constant A 0 576
Speci1fic heat equation constant B 93 493
Speci1fic heat equation constant C -31 227
Antoine equation constant A 6 95464
Antoine equation constant 8 1344 8
Antoine equation constant C 219.48
Heat of vaporization (Btu/lb-mole) 14262 60
. J

Figure 9. Changing the Parameters for TOLUENE.,

Now, select the Inlet HAP concentration (ppmv) parameter and press [Enter]. Add a Calculation value of
73 ppmv. Use the [UpArrow] and [DnArrow] keys, the [Enter] key or the [F10] key to return to the

TOLUENE parameter menu. Press [Esc] to return to the pop-up menu of pollutants and then [Esc] again
to return to the HAP menu.

STREAM/HAP/REVIEW

Once you have selected the pollutants for the stream, you may get a pop-up menu of them by pressing R

for Review. The screen will appear again as in Figure 8 and CAT will work as before.

13
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STREAM/HAP/ADD

CAT stores a data base of several hundred air toxic species. You may select any one specifically by
invoking A for Add from the HAP menu. There will be a slight delay while CAT accesses the data base.

Now, press A for Add. Use the [Home], [End], [PgUp], and [PgDn] keys to view the entire pop-up

menu

Figure 10 depicts a portion of the pop-up menu of air toxics which may be evaluated by the CAT program.
A pollutant is added to the stream by selecting it from this menu. As you do so, you will notice that the

pollutant you selected disappears from the menu. You may continue to select pollutants from the menu by
pressing [Enter).

Note: Each pollutant you choose will be loaded from the data base and will consume several thousand

bytes of memory. As a matter of practicality, you may wish to restrict the number of pollutants evaluated.

é N
Generate Review Add Delete
Add a HAP to the 1ist of HAPs selected for evaluation

83-32-9 ACENAPHTHENE
208-96-8 ACENAPHTHYLENE

75-07-0 ACETALDEHYDE

64-19-7 ACETIC ACID

108-24-7 ACETIC ANHYDRIDE

67-64-1 ACETONE

75-05-8 ACETONITRILE

74-86-2 ACETYLENE

50-78-2 ACETYLSALICYLIC ACID

107-02-8 ACROLEIN

79-06-1 ACRYLAMIDE

79-10-7 ACRYLIC ACID

107-13-1 ACRYLONITRILE

15972-60-8 ALACHLOR
107-18-6 ALLYL ALCOHOL
7429-90-5 ALUMINUM

133-90-4 AMIBEN

92-67-1 AMINOBIPHENYL,4-

504-29-0 AMINOPYRIDINE,2-

N

Figure 10. The Add Menu can Select any Species in the CAT Data base.
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Now, press [Esc] to return to the HAP menu.

STREAM/HAP/DELETE

To remove a pollutant from the list of pollutants in the stream, press D for Delete and a menu similar to
Figure 8 will appear. Each pollutant you select from the menu will be deleted from the stream and from

the menu display.

Now press [Esc] to return to the Stream menu

STREAM/CLEAR

Now, press C for Clear.

CAT will ask if you are really sure that you want to clear the stream information; answering Y will erase
all stream data from memory. The Clear option is particularly helpful if you want to review another stream

from the same plant, but don't want to type in the plant identifying data again.

Now, press [Esc] or N to abort the clear operation, and press [Esc] again to return to the main menu.

DEVICE
Now, press D for Device.

A menu with the options Type and Parameters will appear.
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DEVICE/TYPE
Now, press T for Type.

Figure 11 depicts what your display should look like. The devices in the pop-up menu are those devices
which might be applied to an organic vapor stream. As with the Stream parameters, there are a number of
parameters attached to each kind of device. Therefore, you cannot choose the Parameter option before
you have specified the Type. Also, once a device type has been selected, choosing another will destroy
any device data you have already entered. If you find yourself in this menu by accident and want to
abandon the menu, press [Esc].

e )
Type Parameters

Choose control device type for permit evaluation.
Select a device and press Enter, or Esc to abort.

Thermal Incinerator
Catalytic Incinerator
flare

Carbon Adsorber

Packed Column Scrubber
Condenser

Figure 11. Selecting a Device Type.

Now, select the Thermal Incinerator and press [Enter].
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DEVICE/PARAMETERS
Now, press P for Parameters.
Your display should appear as in Figure 12, with a pop-up menu of parameters. The left-jusufied

parameters in all upper-case (e.g., DESIGN RELATED PARAMETERS) are present to orgamze the

parameters; you cannot enter data for them.

- N\
Type Parameters
Enter parameters describing the device
Select Thermal Incinerator parameter and press Enter, or Esc to exit
r Parameter Appl Calc - Checkedh
DESIGN RELATED PARAMETERS.. .. . e teene e .
Destruction efficiency (%) 99
Combustion temperature (degF) 1800
Residence tme (sec) 75
Is a heat exchanger used? (Y/N) Y
Emission stream temp. after preheat (degF) 960
Excess air (%) 0
Heating value of supplement fuel (Btu/scf) 882
Reference temperature (degF) 70
COST RELATED PARAMETERS . e e . .
Duct cost ($/1inear ft) 50
Length of duct (ft) 100
Total pressure drop (1n H20) 6
Average equipment Nh1fe (yr) 10
Operator labor requirements (hr/shift) 5
Maintenance labor requirements (hr/shift) 5
- J

Figure 12. The Parameter Menu for a Thermal Incinerator.

Explore the menu. As with other parameter pop-up menus, selecting any parameter will cause a parameter
form to appear.
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August,

Now, select the Combustion temperature using [UpArrow] and [DnArrow], then press [Enter].

Figure 13 presents the parameter form for the vanable Tc.

-

r

Type

Parameters

Enter parameters describing the device
Select Thermal Incinerator parameter and press Enter, or Esc to exit
Press F1 for a table of suggested combustion temperatures

Parameter
DESIGN RELATED PARAMETERS. . .
Destruction efficiency (¥%)

Appl Calc = Checked:

99

= Tc
Combustion temperature (degF)

Applicant value

Recommended value

C Calculation value 1800

Checked

Maintenance labor requirements (hr/shift)

.

_/

Figure 13. Changing the Calculation Value for the Combustion Temperature.
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Now, press [F1] for on-line help.

August, 1988

If you follow the suggestion on line 4 of the display, you will receive on-line help for this parameter (see

Figure 14). Help is available from many of the fields in the CAT program. From any field, simply press

the help key, [F1], and the text should be displayed in the lower portion of the screen. While in the help

window, you may scroll the text by using the arrow keys. To turn help off, press the help key again.

(

\
Type Parameters
Enter parameters describing the device.
Select Thermal Incinerator parameter and press Enter, or Esc to exit.
Use cursor pad keys to scroll through help file
Parameter Appl Calc - Checkedh
(DESIGN RELATED PARAMETERS .o . ..
Destruction efficiency (%) 99
F Te 1
Based on the required destruction efficiency, the combustion
temperature and residence time are determined from Table 4-1
n the manual:
Nonha logenated Stream Ha logenated Stream
Required
Destruction Combustion Residence Combustion Resdence
Efficiency Temperature Time Temperature Time
DE (%) Te ( F) tr (sec) Te ( F) tr (sec)
98 1,600 075 2,000 10
99 1,800 075 2,200 10
J

Figure 14. Getting On-Line Help.

Now, press [F1] again to turn help off. Press [Esc] to return to the Parameters menu, and press [Esc]

again to return to the Device menu. Then press [Esc] once more to return to the main menu.
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REVIEW
Now, press R to Review the application.

The Review menu (Figure 15) allows you to see the results of the review on your display or print them on

your printer. You can also control which portions of the review that you want to see.

4 )

Evaluate Cost View Print
Evaluate the applicant’s design parameters

Figure 15. The Review Menu.

20



Tutorial Manual for CAT, Version 1.0 August, 1988

REVIEW/EVALUATE
Now, press E to Evalute the application.

Your display should appear as in Figure 16. The Intermediate Results always list intermediate computed

values. This s intended to help you trace the calculations performed by CAT. The Permit Evaluation

section lists the parameters from the PERMIT EVALUATION section of the device parameter menu. If

the evaluation 1s longer than the display box, you may scroll through 1t by using the [UpArrow],

{DnArrow], [PgUp], and [PgDn] keys.

0 A
Evaluate Cost View Print

Evaluate the applicant's design parameters
Press PgUp, PgDn, Home, and End to scroll, Esc when finished

Intermediate Results:
Cpair(960) = 0.0189
Cpair(1800) = 0.0203
Qc =0
deltaTLM = 840
Permit Evaluation
Supplementary heat requirement (Btu/min) 313486
Supp lementary fuel flow rate (scfm) 355
Flue gas flow rate (scfm) 15355
Combuston chamber volume (ft3) 859
Heat exchanger surface area (ft2) 4279

Figure 16. Evaluating the Design Parameters.

Now, press [Esc] to return to the Review menu.

21



Tutorial Manual for CAT, Version 1.0

REVIEW/COST

Now, press C to get estimates of the Cost of the equipment.

August,

Figure 17 shows the detail produced by running the Cost option. The total capital investment and

components of the annualized cost are presented.

r

)
Evaluate Cost View Print
Present estimates of the capital and annualized cost
Press PgUp. PgDn, Home, and End to scroll, Esc when finished
Total Capital Investment (June 1985 Dollars)
355462
Direct Operating Costs
Natural Gas 778515
Electricity 39867
Operator Labor 6197
Operator Supervision 930
Maintenance Labor 6197
Maintenance Materials 6197
Indirect Operating Costs
N y,

Figure 17. Computing Capital and Operating Costs.

Now, press [Esc] to return 1o the Review menu.
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REVIEW/VIEW

Now, press V for the View option.

Your display should appear as in Figure 18, with a pop-up menu of four choices on the left side of the
display. View 1s intended to allow you to preview the report before 1t 1s pnnted. View and Print will
produce exactly the same results, except that View sends its output to a window on the screen, while Print

sends output to a file or the printer.

( N
Evaluate Cost View Print
Preview a report of the evaluation and costs.
design
cost
device
all
~ _

Figure 18. Viewing a Report on the Screen.
If you select design or cost from the menu, you will get the same report as if you selected Evaluate or
Cost, above. If you select device, you will receive a report detailing how well suited the device may be to
the emussion stream. If you select all, you will receive a report with all of the design, cost, and device

data.

Now, select device from the menu and press [Enter]. Then press [Esc] to return to the Review menu.
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REVIEW/PRINT

Now, press P for Print.

August, 1988

Figure 19 shows CAT prompting you for the file name to which you wish your report to go. The default

name PRN provided for you will send your output to the printer. If you wish the result to go to a file,

erase the "PRN" and enter the name of the file in which you wish to store the report. Otherwise, the Print

option behaves the same as the View option, described above.

—

Evaluate

File Name. PRN
Enter the name of

Cost View Print
Print a report of the evaluation and costs

the fi1le i1n which to place the report.

Figure 19. Printing a Report.

Now, press [Esc] to return to the Review menu without printing. Press [Esc] again to return to the main

menu.
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FILE

Now, press F for File.

The File opuion allows you to save your evaluation on disk and recall it later; a handy way to save that

hard work.
FILE/SAVE
Now, press S for Save.

Figure 20 shows CAT asking for the name of the file in which to save the current review data. The name

entered must be any valid DOS pathname. Some possibilities are:

glaze.cat

A:glaze.cat
glaze\streaml.cat
\John\nov88\glaze.cat

The first example shows using a simple file name. Refer to your DOS manual for the rules goveming file
names. The second example demonstrates saving a file on a floppy in drive A. Examples three and four
demonstrate taking advantage of the DOS file hierarchy to organize the files you use. See your DOS
manual for more on directory hierarchies.
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August, 1988

If you enter the name of an existing file, CAT will ask if you want to overwrite the file. If you answer Y,

the previous contents of the file will be lost.

—

Save Recall
Save the review information to a disk file for later use
File Name t1 cat
Enter the name of the file in which to save the evaluation

Figure 20. Saving Your Work.

Now, enter MYFILE. CAT and press [Enter] to save the review.

Note: Unlike other menu options in CAT, when a File option is finished, it returns you automatically to

the main menu. This was done intentionally to make the program easier for you to use.
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FILE/RECALL

Now, press F for File. then R for Recall.

August, 1988

Figure 21 shows the CAT program asking for the name of the file to read. The file named must conform 1o
the rules discussed under FILE/SAVE, above, and must have been Saved by the CAT program.

—

File Name

Save Recall
Recall permit nformation which was Saved previously.

Enter the name of the file from which to read the evaluation

N

Figure 21. Recalling a Review.

Now, press [Esc] to return to the File menu, and press [Esc] again (o return 10 the main menu.
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CLEAR

Now, press C for Clear.

August,

1988

The Clear option provides a way for you to start the CAT program from scratch without having to quit and

return to the program. As shown in Figure 22, Clear asks you if you really want to proceed before it clears

memory.

e R
klant Stream Device Review File Clear
Erase the current review from memory.
Are you really sure? [Y/N]
Clear w11l erase everything from memory
. J/

Figure 22. Clearing Memory.

Now, press N to leave without clearing memory.

28



Tutorial Manual for CAT, Version 1.0 August, 1988

QuIT
Now, press Q to Quit the CAT program.

CAT will ask if you are sure that you want to quit. Be sure that you have saved whatever you are working

on before you answer Y, as all your work will be lost if you do not.

Now, press Y 1o return 1o DOS.
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SECTION 4

DATA ENTRY CONTROL KEYS
Edit Commands

[Backspace)
Deletes character to the left of cursor and closes text.

[Del}
Deletes character at the cursor and closes text.

{Ins]
Toggles insert mode. In insert mode, characters are inserted at the current cursor positon.
Characters will not be inserted if they would push existing text beyond the boundary of a field.

(F5]
Clear the data field. Protected characters remain.

[Fé]
Clear to end of field. Protected characters remain.

Field Commands

(Left Arrow]
Moves cursor to the left without affecting text.

[Right Arrow]
Moves cursor to right without affecting text.

[Enter]
Enter a block of data into the computer's memory.

(PgUp]
[UpArrow]
Pnor field is made the active field. If already in the first field, remain in that field.

(PgDn]
[DnArrow]
Next field is made the active field. If already in the last field, remain 1n that field.

[Home]
Go 10 the first field on the form.

[End]
Go to the last field on the form.
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(Esc]

Abort the data entry.
[F10]

Exit the data form; save entered data.
Help Commands
(F1]

Enter and Exit (toggle) Help Window.
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APPENDIX A - COSTING METHODOLOGY

The following is a discussion of the methodology used to develop costs for controlling emissions of
hazardous air pollutants. The approach and cost data are those used in the manual Control Technologies
for Hazardous Air Pollutants, (EPA/625/6-86/014) unless specified differently. The possible control
devices include thermal incinerators, catalytic incinerators, flares, carbon adsorbers, packed column
scrubbers, condensers, fabric filters and venturi scrubbers. A general costing methodology for capital and
annualized costs is developed and a brief description of costing for each control device is presented. This
appendix concludes with an example of costing a thermal incinerator. All costs in this program are based
on June 1985 dollars.

TOTAL CAPITAL INVESTMENT
The total capital investment can be broken down into direct and indirect costs, as shown below:

Direct Capital Costs:
Control Device
Auxiliary Equipment
Instrumentation and Controls
Taxes
Freight Charges

Direct Installation Costs:
Site Preparation
Foundation and Supports
Erection and Handling
Electrical
Piping
Insulation
Painting

Indirect Capital Costs:
Engineering and Supervision
Construction and Field Expenses
Construction Fee
Start-Up
Performance Test
Model Study

Based on the cost data available, the cost for some control devices includes auxiliary equipment,
instrumentation and controls, taxes, and freight charges in the direct capital cost. For example, the cost
for a thermal incinerator system includes the cost of a heat exchanger (if heat recovery is practiced), an
exhaust stack, instrumentation and controls, taxes, and freight charges, but the cost for ducting must be

determined separately. For each control device, the cost items included in the total capital investment are
shown below.
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ANNUAL OPERATING COSTS

The annual operating costs are also broken down into direct and indirect costs:
Direct Operating Costs:

Utilities
Natural Gas
Electricity
Steam
Water

Operating Labor and Maintenance
Operating Labor
Supervisory Labor
Maintenance Labor
Maintenance Materials

Replacement Parts
Replacement Labor
Indirect Operating Costs:

Overhead

Property Tax

Insurance

Administrative

Capital Recovery
Summing the direct and indirect operating costs yields the total annualized operating cost. The net
annualized cost is determined by subtracting the solvent recovery credit, where it applies.

THERMAL INCINERATOR

Total Capital Investment
Incinerator System Cost (Reference 2)
Ducting Cost

Direct Operating Costs
Natural Gas Cost
Electricity Cost
Operating Labor and Maintenance Cost

Indirect Operating Costs
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CATALYTIC INCINERATOR

Total Capiral Investment
Incinerator System Cost (Reference 2)
Ducting Cost

Direct Operating Cost
Natural Gas Cost
Electricity Cost
Operating Labor and Maintenance Cost
Replacement Parts Cost
Replacement Labor Cost

Indirect Operating Costs

FLARE

Total Capital Investment
Flare System Cost (Reference 3)
Ducting Cost

Direct Operating Costs
Natural Gas Cost
Electricity Cost
Steam Cost
Operating Labor and Maintenance Cost

Indirect Operating Costs

CARBON ADSORBER

Total Capital Investment -
Adsorber System Cost (Reference 2)

Direct Operating Costs
Steam Cost
Natural Gas Cost
Electricity Cost
Operating Labor and Maintenance Cost
Replacement Parts Cost
Replacement Labor Cost

Indirect Operating Costs

Solvent Recovery Credit
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PACKED COLUMN SCRUBBER

CONDENSER

Total Capital Investment
Absorber System Cost
Ducting Cost
Fan Cost
Stack Cost
Platform Cost
Packing Cost

Direct Operating Costs
Electricity Cost
Absorbent Cost
Operating Labor and Maintenance Cost

Indirect Operating Costs

Total Capital Investment
Condenser System Cost
Refrigerant Cost

Direct Operating Costs
Electricity Cost
Coolant (water or other) Cost
Operating Labor and Maintenance Cost
Indirect Operating Costs

Solvent Recovery Credit

FABRIC FILTER

Total Capital Investment
Baghouse Cost
Bag Cost
Ducting Cost
Fan Cost

Direct Operating Costs
Electricity Cost
Operating Labor and Maintenance Cost
Replacement Parts Cost
Replacement Labor Cost

Indirect Operating Costs
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VENTURI SCRUBBER

Total Capital Investment
Scrubber System Cost
Ducting Cost
Fan Cost

Direct Operating Cost
Water Cost
Electricity Cost
Operating Labor and Maintenance Cost

Indirect Operating Cost

EXAMPLE

Following is an example of estimating the costs for the purchase and operation of a thermal incinerator.
The example incorporates the emission stream characteristics presented in the HAP manual.

The emission stream parameters are:

Maximum flow rate (scfm) 15000
Pressure (mmHg)

Temperature (degF) 120
Heat content (Btu/scf) 04
Oxygen content (%) 20.6
Moisture content (%) 20
Are halogenated organics present? (Y/N) N
Are metals present? (Y/N) N

The input design parameters are: -

Destruction efficiency (%) 99
Combustion temperature (degF) 1800
Residence time (sec) 0.75
Is a heat exchanger used? (Y/N) Y

Emission stream temp. after preheat (degF) 960
Excess air (%) 0
Heating value of supplement. fuel (Btu/scf) 882
Reference temperature (degF) 70
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The costing parameters are:

Duct cost (June 1985%/linear ft)

Length of duct (ft)

Total pressure drop (in. H20)

Average equipment life (yr)

Operator labor requirements (hr/shift)
Maintenance labor requirements (hr/shift)

The evaluation parameters relevant to costing are:

Supplementary fuel flow rate (scfm)
Flue gas flow rate (scfm)

Calculation of percent heat recovery:
HR = 100 X ((The - Te)/(Tc - Te))

where:

50
100

10
0.5
0.5

355
15,355

The = emission stream temperature after preheat (degF)
Te = emission stream temperature before preheat (degF)

Tc = combustion temperature (degF)

HR = 100 X ((960 - 120)/(1800 - 120))
HR = 50%

Determination of incinerator cost for 50% heat recovery:

August, 1988

The incinerator cost equation from Reference 2 is based on a combution temperature of
1,500 degF. Use the following correction for the flue gas flow rate for temperatures higher than

1,500 degF:

Qfgc = Qfg X (Tc + 460.0)/1960.0 = 17,705 scfm

Equipment Cost = $187,284 (April 1986 dollars)
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The equipment cost must be de-escalated from April 1986 dollars to June 1985 dollars,
where:

April 1986 Index = 310.6
June 1985 Index = 336.2

Equipment Cost = (187,284) X (336.2/310.6)
Equipment Cost = $202,458 (1985 dollars)

Note: This includes instrumentation and controls. Assuming that these costs are 9-10% of the
equipment cost, the actual equipment cost is $202,458 X 0.9, or $182,213.

Determination of ducting cost:
Duct Cost = (Length of Duct) X (8 per linear foot)
Duct Cost = (100 feet) X (50 $ per linear foot)
Duct Cost = $5,000 (1985 dollars)
Determination of Total Capital Investment (TCI):
Table 3-3 from Capital and Operating Costs of Selected Air Pollution Control Systems (Reference 4) is

used to determine the total capital investment. The sum of the control device cost and ducting cost
(auxiliary equipment) yields the variable ‘A’".

Direct Costs
Control Device 182,213
Ducting 5.000

Purchased Equipment Costs (A) 187,213

Instruments and Controls 0.10A
Taxes 0.03A
Freight 0.05A
Purchased Eqpt. Costs 1.00A
Total Purchased Equipment Cost (B) 1.18A
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Direct Installation Costs

Foundations and Supports 0.08B
Erection and Handling 0.14B
Electrical 0.04B
Piping 0.02B
Insulation 0.01B
Painting 0.01B
Total Direct Installation Costs 0.30B
Total Purchased Eqpt. Cost 1.00B
Total Direct Costs 1.30B
Indirect Costs
Engineering and Supervision 0.10B
Construction & Field Expenses 0.05B
Construction Fee 0.10B
Start-Up 0.02B
Performance Test 0.01B
Contingencies 0.03B
Total Indirect Costs 0.31B
Total Direct and Indirect Costs 1.61B

To determine the total capital investment, sum the control device cost and the ducting cost, then multiply
by the capital cost factors. )

Purchased Equipment Cost = Incinerator + Ducting
Purchased Equipment Cost = 182,213 + 5,000
Purchased Equipment Cost = $187,213

TCI = Purchased Equipment Cost X 1.18 X 1.61
TCI = $355,666
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Elements of the Operating Costs (Table 5-9, Reference 1):

Element Unit Cost/Factor

Natural Gas $0.00425 per scf

Water $0.0003 per gal

Steam $0.00504 per Ib
Electricity $0.059 per kWh

Solvent As Applicable

Operator Labor $11.53 per hour
Supervisory Labor 15% Operator Labor
Maintenance Labor $11.53 per hour
Maintenance Matenals 100% Maintenance Labor
Replacement Parts As Applicable
Replacement Labor 100% Replacement Parts

Determination of Indirect Operating Costs:

Overhead 60% of Operator, Supervisory, Maintenance and Replacement
Labor (Reference 2)

Property Tax 1.0% of Total Capital Investment

Insurance 1.0% of Total Capital Investment

Administrative 2.0% of Total Capital Investment

Determinauon of Natural Gas Cost:
Gas = Fuel Flow Rate X Annual Operation X Gas Price
Annual Operation = (8600 hrs per yr) X (60 min per hour) = 516,000 min per yr

Gas = (355 scfm) X (5.16ES min per yr) X (0.00425 $ per scf) = $778,515

Determination of Fan Electricity Requirement (FER):
FER = 2.0E4 X Qfg.a X delta P X Annual Operation
where: Qfg,a = Flue Gas Flow Rate at Actual Conditions
Qfg.a = Qfg X (Tc + 460)/530
Qfg,a = 15,355 X (1,800 + 460)/530
Qfg,a = 65,480 acfm

FER =2.0E4 X 65,480 X6 X 8600 = 675,750 kWh
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Determination of Electrical Cost:
Elec = FER X Elec Price

Elec = (675,750 kWh) X (0.059 S per kWh) = $39,870

Determinatromrof-Eabor Costs:
Operating Labor = Labor Required X Annual Hours X Labor Rate

Operating Labor = (0.5 hr per shift) X (2 shifts per 8 hr) X (8600 hr per yr)
X (11.53 $ per hr)

Operating Labor = $6,200

Supervisory Labor Cost = 15% of Operating Labor Cost

Supervisory Labor Cost = $930

Maintenance Labor = Labor Reqd X Annual Hrs. X Labor Rate

Maintenance Labor = (0.5 hr per shift) X (2 shifts per 8 hr) X (8600 hr per yr)
X (11.53 $ per hr)

Maintenance Labor = $6,200

Maintenance Materials = Maintenance Labor

Operating Labor and Maintenance Cost = 6,200 + 930 + 6,200 + 6,200
Operating Labor and Maintenance Cost = $19,530
Replacement Labor = $0 (not required for Thermal Incineration)

Replacement Parts = $0 (not required for Thermal Incineration)
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Determinauon of Direct Operating Costs (DOC)

DOC = Gas + Elec + Operating Labor and Maintenance Cost + Replacement Labor +
Replacement Parts

DOC = 778,515 + 39,870 + 19,530+ 0+ 0

DOC = $837,910

Determination of Indirect Operating Costs (IDOC):

IDOC = Overhead + Property Tax + Insurance + Admuinistration

where:
Overhead = 60% of Operator, Supervisory, Maintenance, and

Replacement Labor
= 60% (6,200 + 930 + 6,200 + 0) = $7,998

Property Tax = 1% TCI = $3,557
Insurance = 1% TCI = 33,557
Administration =2% TCI=$§7,114

Indirect Operating Costs = $22,226

Determination of Total Annual Operating Costs:
Total Operating = Direct Cost + Indirect Cost
Total Operating = 837,910 + 22,226

Total Operating = $860,136

Determination of Capital Recovery Cost:

i+

(A+ip-1

where:
CREF represents capital recovery factor
i represents interest rate (fraction)
n represents equipment life (years)

CRF =0.163 at 10% for 10 years
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Annual Capital Recovery = CRF X TCI = $57,974

Determinauon of Net Annualized Cost:
Net Annualized Cost = Total Operating + Capital Recovery - Recovery Credit
Recovery Credit = 0

Net Annualized Cost = 860,136 + 57,974 - 0 = $918,110

REFERENCES

1.) Control Technologies for Hazardous Air Pollutants,
Report No. EPA/625/6-86/014, U.S. Environmental Protection Agency,
Research Triangle Park, NC, September 1986.

2.) EAB Control Cost Manual, 3rd Edition,
Report No. EPA/450/5-87-001A, U.S. Environmental Protection Agency,
Research Triangle Park, NC, February 1987.

3.) Chemical Engineering, "Costs of Flares," Volume 90,
Number 4, February 21, 1983, p.89-90.

4.) Neveril, R.B., Capital and Operating Costs of Selected Air

Pollution Control Systems, Report No. EPA/450/5-80-002,
Research Triangle Park, NC, December 1978.
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APPENDIX B - DATA INPUT FORMS

In the following forms, fields preceded by asterisks (*) must be entered by the user in order for CAT to
perform calculations.
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CAT Analysis for Thermal Incinerator

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

* Maximum flowrate(scfm) ...........oviii i,
*Pressure(mmHg) .............cociiiiiiiiiiaine,

* Temperature (degF) ...t

*Heatcontent (Btu/scf) .......ooviiineiin il

*Oxygencontent (%) .. .oovevivniiiniiiiaaie i

* MOISture Content (%) . . -« o v cvevrvennrcerenennonnnnen

Relative humidity (%) .. .....ccovviieinnniinaatn

* Are halogenated organics present? (Y/N) . .......ooviiiiiiiinniini e,
Aremetalspresent? (Y/N) .......covivvin i,

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) ...........cooiiiieiie ot
* Inlet HAP cOncentration (PPMV) .« ..ot v evnrnvranrnaannccers
Heat of vaporization (BtwIb-mole) ...........coveevveiinenan e

Design-related Input Parameters:

* Destruction efficiency (%) . ... cocvvviveeii ..

* Combustion temperature (degF) ... .....covivriiniieiiiaaans

*Residence time (SEC) .. ..o v vrvvven e enranaenannn
*Isaheatexchangerused? (Y/N) .........ccoviiiiniiinit,

* Emission stream temp. after preheat (degF) . ...t
TEXCESS AN (%) oo vevevneneiennoncnanenianas

* Heating value of supplementary fuel (Btu/scf) . ..............cooiiiiint.
* Reference temperature (degF) ...t

Cost-related Input Parameters:

*Ductcost (1985 $/linear ft) . .......cccoveneiiiiiiiiinn.,
*Lengthofduct (ft) ..........coiiiiiiinen,

* Total pressure drop (in. H20) . ... .....oviiviiiniiiiinnnns,

Average equipmentlife (yr) . ..........coooiiii i,

* Operator labor requirements (hr/shift) . ................. ..ol

* Maintenance labor requirements ¢(he/shift) .. ...l o,
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CAT Analysis for Catalytic Incinerator

Plant:
Name:
Address:
City: State:
Contact:
Phone:
Reviewer:

Emussion Stream Input Parameters:

Zip:

August, 1988

* Maximum flowrate (scfm) . .. ... .c.iiii i

Pressure (mmHg) .........coviviiiiiiiiity

* Temperature (degF) . ... ....covvviiiiiiiiin e,

* Heatcontent (Btw/scf) . ........covviiei it
*Oxygencontent (%) . ... ooverenrriineaaanas

* Moisture Comtent (%) . . o v v v ierecien e anas

Relative humidity (%) . . - . .. ... oo it e

Are halogenated organics present? (Y/N) . .......ooiiiiieiiin e,
Aremetalspresemt? (Y/N) .. oovviiinn i iiinnnanens

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) ............c.cooiiieiiiiiint
* Inlet HAP concentration (PPMV) ....ccvvveriiierevnecaronaaosens
Heat of vaporization (Bw/lb-mole) . ...l

Design-related Input Parameters:

* Destruction efficiency (%) . .....covviv i iiiiiii e
*Isaheatexchangerused? (Y/N) .............oooiiiiiniae,

* Emission stream temp. after preheat (degF) .......... ..o

* Temp. of gas fromthebed (degF) ..........ooevieiiiiaiiiin it

* Temp. of combined gas entering thebed (degF) .. .................coiinn
* Space velocity (perhr) .. oo oo

FEXCESS AL (F0) oo o v vvveiae e

* Heating value of supplementary fuel (Btu/scf) .............ooiiieiiiatt.
* Reference temperature (degF) .. .......ocoiv i

* Min. temp. of stream for adequaterxn. (degF) .. .............. ..ol
* Min. temp. of gas from the catalystbed (degF) .............. ..o
* Max. temp. of gas from the catalystbed (degF) ................. ..ot
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Cost-related Input Parameters:

*Ductcost (1985 $/linear ft) . .. ...covvvrvvineneinenennnnnn.
*Lengthofduct (1) .......covvivninnniennninna.t,

* Total pressuredrop (in. H20) . .........coviiie i inn .,

* Average equipmentlife(yr) . ...l

* Operator labor requirements (he/shift) . ...........ccovviiiiiii Lt

* Maintenance labor requirements Chr/shift) .. ............ ool
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CAT Analysis for Flare

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

*Maximum flowrate (SCfm) ... ....oiitiiii it
Pressure(mmHg) . ...l

*Temperature (degF) ...,

* Heatcontent (Btu/scf) .. ...ocvvnvnnnaienn e,
Oxygencontent (%) . ... .covviiiirnnraranneneeninns

Moisture content (%) . . ..o vveevvvvrnrrr s oiiananns

Relative humidity (%) . . .......ovvvivi i,

Are halogenated organics present? (Y/N) . .......oooiiiiiiiiiinnnn
Aremetalspresent? (Y/N) . ..oooiiiin i

Design-related Input Parameters:

* Destruction efficiency (%) . .....covvvriiiii i

*Flare tip diameter (in) .. ..........cooiiiiiinn .

* Temperature of flare gas (degF) . . ............ccvaiiaiinannen,

* Flare gas heat content (Btw/sef) . ........ccovvviiii ot

* Supplementary fuel heat content (Btu/scf) .. ................iiiiit
* Avg. mol. wt. of the stream (Ib/lb-mole) . ..........cccviiiiiaia it

Cost-related Input Parameters:

*Ductcost (1985 $/linearft) . .......covvviveninninnnnn,
*Lengthofduct (ft) ...........covviiveiiiiiinnnn,

* Total pressuredrop (in. H20) . ... ...t
Averageequipmentlife (yr) ...............i i,

* Operator labor requirements (hr/shift) . ..............co0oiiiiiiia

* Maintenance labor requirements (he/shift) .. .............co it
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CAT Analysis for Carbon Adsorber

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emussion Stream Input Parameters:

* Maximum flowrate (scfm) .. ......cooeviniiii i,

Pressure (mmHg) .......covviiiiiinianiiiainns

* Temperature (degF) ...............ccooiiiieiiinns

Heatcontent (Btu/scf) . .....ovineeiniiniinnnnnnenns

Oxygencontent (%) . ......covverreneranneenansnnns

Moisture content (%) . ... oo vvvvreiereniiearenanans

* Relative humidity (%) ....ocvvviiniiiiiiiennnneneenns

Are halogenated organics present? (Y/N) . ........oooiiieiiiiinnn,
Aremetalspresent? (Y/N) . ......oitiiiiinnneninnneneens

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) . ................coiiiiiiianae,
* Inlet HAP concentration (PPmMv) . ..coovveiveennvanronenrascnsss
Heat of vaporization (Btu/lb-mole) . .........cooriiiiieiie i,

Design-related Input Parameters:

* Removal efficiency (%) .. .. ....coviiiireeiin e,

* Adsorptive capacity (I1b HAP/100 Ibcarbon) ............cooviiniinnne,
*Numberofbeds...........cciiriiinriiiinnnnen

* Cycle time foradsorption (hr) . . .. ..o eiaii et

* Cycle time forregeneration (hr) . ............covieeiaen ot

* Stream velocity through the bed (f/min) ... e,

* Steam ratio (Ibsteam/lbcarbon) .. ........... ...l

* Steam inlet temperature (degF) .. ........ o i

* Condensed steam outlet temperature (degF) .. ............... oot
* Cooling water inlet temperature (degF) ..........ccoveviii i,

* Cooling water outlet temperature (degF) . ..........ovvviiiaiiin

* Carbon bed density (Ib/ft3) . . ....ovvvneeneniii it

* Cycle time for drying and cooling (hr) .. ........cooiiiiiiiiniinnnn,

* Latent heat of vaporization (Btw/lb) . ............... .ol

* Average specific heat of water (Btu/lb-degF) .................ccooiiii ot

* Overall heat trans. coeff. (Btu/hr-ft2-degF) . .......oovvvevnearernennennnn.
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Cost-related Input Parameters:

* Value of recovered product (19853/1b) . ........c..oiiiiiiiiiinian e
*Ductcost (19858 linear ft) . .............cciviiiiernnnenin,

* Stack capital cost (19858) ........co ittt
Lengthofduct (ft) ...,

* Total pressure drop (in. H20) . ...........ooeiiiinnt,

Average equipmentlife (yr) . ............ ..o i

* Operator labor requirements (hr/shift) . ...t

* Maintenance labor requirements (hr/shift) .................coooiiiiii .
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CAT Analysis for Packed Column Scrubber

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

* Maximum flowrate (sefm) ... ...l i

Pressure mmHg) .......... ..o

* Temperature (degF) . ...........c ittt

Heatcontent (Btu/scf) . ......cociviivrinienninernnns

Oxygencontent (%) . .....coooviiievrnanneenencanns

Moisture content (%) . ... ..covvieriiiinteniiiannennn

Relative humidity (%) . ... .. ovvviiniiiinieaan e,

Are halogenated organics present? (Y/N) . ....... ... ..ot
Aremetalspresent? (Y/N) . .....oooviiiiiiiiinineninnnn,

Hazardous Air Pollutant:
Molecular weight (Ib/ib-mole) . ............. ... ..ot

* Inlet HAP concentration (Ppmv) . ......covvniiinranenrrannnnns
Heat of vaporization (Btu/lb-mole). ..ot
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Design-related Input Parameters:

* Removal efficiency (%) .. ............

What solvent isused? ..............

* Slope of the equilibriumcurve . .............

* Absorption factor .. ............

* Schmidt number for HAP/emission stream . .............
* Schmidt number for HAP/solvent .. ............

* Density of the emission stream (Ib/ft%) ..............
* Density of the solvent (Ib/ft3) ... ...........

Avg. mol. wt. of the stream (Ib/lb-mole) ..............
* Mol. wt. of the solvent (Ib/lb-mole) ..............

* Solvent viscosity (cenupoise) . ............
*Packingmatenal ..............

* Packingconstanta ..............

* Packing constantb.............

* Packingconstantc.............

* Packing constantd .............

* Packing constantepsilon . ............

* Packingconstant Y. ............

* Packing constantS.............

* Packingconstant g.............

* Packing constantr.............

* Fraction flooding velocity . ............

Cost-related Input Parameters:

* Cost of the packing material (1985 $/f®) . ............
* Cost of fans and motors (19858).............

Duct cost (1985 $/linearft).............

* Stackcost (19858) . ............

Lengthof duct(ft).............

* Total pressure drop (in. H20) .............

Average equipment life (yr) . ............

* Operator labor requirements (hr/shift) . ............

* Maintenance labor requirements (hr/shift) ............
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CAT Analysis for Condenser

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

* Maximum flowrate(scfm) ........coivi it
*Pressure(mmHg) .............. ...l

* Temperature (degF) ......... ..o,

Heatcontent (Btu/scf) .......ccoviviiiiiiiniinivane,

Oxygencontent (%) . .....ovvvvninnnnrrreennaeeeen.

*Moisture content (%) .. ... ...cccveirrirranicanerennas

Relative humidity (%) ... .......ccviriiriiineen e,

Are halogenated organics present? (Y/N) ... ... oo iiiiiiiiiinenn
Aremetalspresent? (Y/N) ... oviiiniiiieiiininnnnnnnen

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) . .......... ..o oL,
* Inlet HAP concentration (PPmv) . .....covvieiirenrrenneenanns
Heat of vaporization (Btu/lb-mole) . ............. ...t

Design-related Input Parameters:

*Removal efficiency (%) ........ccvceiiiiiiiiiiiinanann
*Coolant........ooiviiiiiinn e,

* Inlet coolant temperature (degF) . .. ........ccviiei i

* Overall heat transf. coeff. (Btu/hr-ft2-degF) . .. ........coireiienneennnannn
* Avg. specific heat for coolant (Btu/lb-degF) ...............ccoiiiii i,

Cost-related Input Parameters:

* Value of the recovered product (19858/1b) ... ... ...t
* Total cost of required coolant (19858)..............covv e,

* Total pressure drop (in. H20) . ... .......ccoviiiiiniinnn

Average equipmentlife (yr) . ... il

* Operator labor requirements (hr/shift) . ..................coiiii s,

* Maintenance labor requirements (hr/shift) .. ............ .. ..o il
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CAT Analysis for Fabric Filter

Plant:
Name:
Address:
City: State: Zip:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

* Maximum flowrate (sefm) . ........coiviiiiiiaiii i
Pressure(mmHE) ........covoiiiiiiiiiiaaennn

* Temperature (degF) ..........ooviiiiiiii e,

Moisture content (o volume) . .. . ......oviiiiiiiiiiii e
Particulate content (grains/scf) . . ... ool
Mean particle diameter (MiCrons) ......covveveeeneinenennenens
SO content (PPMV) . ..o ovninriiiiiernnnerennnsanns

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) . ...........cooiiiiii v,
HAP concentration (o mMass) . o . oo vveevervnnenonnnsancannnes
Heat of vaporization (Btu/lb-mole) . . ........oivenineriiiaian,

Design-related Input Parameters:

*Filtercleaningmethod . . .............cocoiiiaiia

* Material type: cotton, WOOl, €1C. . . ... .ccviieiiiiee it
*Airtoclothratio(ft/min) .. ........c.oviviiiiiiiiiietn

* Baghouse configuration . . ..........oovvevvieneninnnn

Cost-related Input Parameters:

* Cost of baghouse (19858) .......coovreneiin i,

* Cost of cloth (1985 $/gross ft2) . . .. .....coiviiriiiinnneinennn.

*Costof fansand motors (1985 %) .. .. oo vviiei i,
*Ductcost (1985 S/linearft) .........covveieiiiiiniinnnnnsn
*Lengthofduct (ft) ............cooeiii it

* Total pressure drop (in. H20) .. .. ...... oo iiiiiein it

Average equipmentlife (yr) ............... ... .. il

* Operator labor requirements (hr/shift) ..................ooiiiiiins,

* Maintenance labor requirements (hr/shift) . ...............cco el
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CAT Analysis for Venturi Scrubber

Plant:
Name:
Address:
City: State:
Contact:
Phone:
Reviewer:

Emission Stream Input Parameters:

Zip:

August, 1988

* Maximum flowrate (scfm) ... ... i iii i e e
Pressure (mmHg) .......... ... .. il

* Temperature (degF) ...........oooiiiiiiiiiien

Moisture content (% volume) . .. ....coviinine i
Particulate content (grains/scf) . .........coiviiiiii i,
Mean particle diameter (MiCTONS) ... ..o vvvevenerien i iisnerens
SO3content (PPMV) . ....oovvivinrrnierrnnnrnenonsn

Hazardous Air Pollutant:

Molecular weight (Ib/lb-mole) . ...........ovviiiiiiiiiia
HAP concentration (o mass) .. .....c.civvveeernnesenrncanns
Heat of vaporization (Btu/lb-mole) . ..ot

Design-related Input Parameters:

* Control efficiency (%) . - ... oo iii i e
* Total pressure drop (in. H20) . ......ooovvn vt

Cost-related Input Parameters:

*Costof fansand motors (1985 8) ........cvve i,
*Ductcost (1985 8/linear ft) . .........coeniiriiiienn s,
Lengthofduct (ft) . ........covvvvieeniiininen,
Averageequipmentlife(yr)........... ...,

* Operator labor requirements (hr/shift) . .............. ..ol

* Maintenance labor requirements (hr/shift) . .............coooeiiieii e,
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APPENDIX C - NOMENCLATURE

English units are used throughout this appendix. Metric conversion factors may be found in Appendix D.

a = packing constant

A = heat exchanger surface area, ft2

A, = carbon bed cross sectional area, ft2

A = absorber column cross sectional area, ft?

A = condenser surface area, ft2

A, = net cloth area, ft2

A, = collection plate area, fi2

A = venturi scrubber throat area, fi2

A, = total cloth area, ft2

ABS = abscissa

AC = adsorption capacity of carbon bed, Ib HAP/100 Ib carbon
A/IC = air to cloth ratio for baghouse, acfm/ft2

AF = absorption factor

b = packing constant

c = packing constant

Cc = annual credits, S/yr

Cra = amount of carbon required, Ib

Cp., = average specific heat of air, Btu/scf-degF

Cr,, = average specific heat of air, Btu/lb-mole-degF

Cpoen = average specific heat of combined gas stream, Btu/scf-degF
CPectacn = average specific heat of coolant, Btu/lb-degF

Cp, = average specific heat of emission stream, Btu/scf-degF
Cp, = average specific heat of emission stream, Btu/lb-degF
Cp, = average specific heat of supplementary fuel (natural gas), Btw/lb-degF
Cp,, = average specific heat of flue gas, Btu/scf-degF

Cp,, = average specific heat of flare gas, Btu/lb-degF

Cp, = average specific heat of water, Btu/lb-degF

Chyur = average specific heat of HAP, Bu/lb-mole-degF

CE = collection efficiency (based on mass), %

CRF = capital recovery factor

CRF, = weighted average capital recovery factor

d = packing constant

D = annual direct labor costs, $/yr

Dy = carbon bed diameter, ft

D = absorber column diameter, ft

D,. = duct diameter, in.

D, = mean particle diameter, microns

D, = venturi scrubber throat diameter, ft
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D, = flare tip diameter, in.

D, = diffusivity in gas stream, ft?/hr

D, = diffusivity in liquid, ft?/hr

D, = annual operating labor cost, $/yr

D, = annual supervision labor cost, $/yr

DE = destruction efficiency, %

DE,_ 4 = reported destruction efficiency, %

DP = stream dew point, degF

ex = excess air, % (volume)

f = fraction

FE = fabricated equipment cost index

FER = fan electricity requirement, kWh

g = packing constant

g = gravitational constant, = 32.2 f/sec?

G = gas (emission stream) flow rate, lb/hr

G,.. = gas (emission stream) flow rate based on column cross sectional area, Ib/sec-fi2

Gt = gas (emission stream) flow rate at flooding conditions based on column cross sectional
area, lb/sec-ft

G = gas (emission stream) flow rate, lb-mole/hr

h, = heat content of emission stream after dilution, Btu/scf

h, = heat content of emission stream, Btu/scf

h, = lower heating value of supplementary fuel (natural gas), Btu/scf

h,, = flare gas heat content, Buu/scf

AH = heat of vaporization of HAP, Btu/lb-mole

H. . = enthalpy change associated with condensed HAP, Btu/min

H, = supplementary heat requirement (heat supplied by the supplementary fuel), Btu/min

H., = condenser heat load, Btu/hr

H w = enthalpy change associated with noncondensible vapors, Btu/min

H . = enthalpy change associated with uncondensed HAP, Btu/min

Hq = height of a gas transfer unit, ft

H, = height of a liquid transfer unit, ft

Hy, = height of a gas transfer unit (based on overall gas film coefficients), ft

Ht o = absorber column packed height, ft

Ht = absorber column total height, ft

HAP__ = quantity of HAP condensed, 1b-mole/min

HAP, = inlet HAP concentration, ppmv

HAP, = quantity of HAP in the emission stream entering the condenser, Ib-mole/min

HAP, = outlet HAP concentration, ppmv

HAP,__ = quantity of HAP in the emission stream exiting the condenser, Ib-mole/min

HP = fan power requirement, hp (horsepower)

HR = heat recovery in the heat exchanger, %

HRS = number of hours of operation per year
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= solvent flow rate, 1b/hr

= solvent flow rate based on absorber column cross sectional area, ib/hr-fi2
= solvent flow rate, gal/min

= solvent flow rate, 1b-mole/hr

= liquud flow rate in venturi scrubber, gal/min
= liquid to gas ratio, gal/103 acf

= lower explosive limit, % (volume)

= slope of the equilibrium curve

= annual maintenance costs, $/yr
= moisture content of emission stream, % (volume)

= annual maintenance labor cost, $/yr

= annual maintenance supervision cost, $/yr

= annual maintenance materials cost, $/yr

= average molecular weight of a mixture of components, 1b/lb-mole

= average molecular weight of a emission stream, Ib/ib-mole

o = average molecular weight of a flare gas, Ib/Ib-mole

salvent = molecular weight of solvent, Ib/lb-mole

HAP = molecular weight of HAP (average molecular weight if a mixture of HAPs 1s present),
1b/lb-mole

= number of carbon beds

= number of gas transfer units (based on overall gas film coefficients)

= oxygen content of emission stream, % (volume)
= ordinate
= total pressure drop for the control system, in. H,O

e

p it

»

| ol o

r

2z3r

avg

28333575

= absorber column pressure drop, 1b/ft2-ft

= emission stream pressure, mmHg

= partial pressure of HAP in emission stream, mmHg
= vapor pressure of HAP in emission stream, mmHg
= absorber column total pressure drop, in. H,0

pressure drop across venturi, in. H,0

= purchased equipment cost, $

= flow rate of gas stream at actual conditions, acfm

= combustion air flow rate, scfm

= flow rate of combined gas stream entering the catalyst bed, scfm
= coolant flow rate, 1b/hr

= cooling water flow rate, Ib/min

fg_oﬁop.o?; B E%{ufn B %cé”ogzz

Q. = emission stream flow rate at actual conditions, acfm
Q.. = saturated emission stream flow rate, acfm

Q = supplementary fuel (natural gas) flow rate, scfm

Q, = flue gas flow rate, scfm

Q,. = flue gas flow rate at actual conditions, acfm
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Q, = flare gas flow rate, scfm

Qn“ = flare gas flow rate at actual conditions, acfm
Q.. = quantity of HAP recovered, 1b/hr

Q, = steam flow rate, Ib/min

Q. = cooling water flow rate, gal/min

r = packing constant

R = gas constant = 0.73 ft3-atm/Ib-mole degR; = 1.987 cal/g-mole K
Rim = relative humidity, %

Ref = refrigeration capacity, tons

RE = removal efficiency, %

RE_, = reported removal efficiency, %

3 = packing constant

S = annual cost of operating supplies, $/yr

Sce = Schmidt number for HAP/emission stream
Sc, = Schmidt number for HAP/solvent system

St = steam rato, Ib steam/Ib carbon

2\ = space velocity, hrt

ol

= cleaning interval, min

= residence time, sec

= temperature, degF

= combustion temperature, degF

= temperature of combined gas stream entering the catalyst bed, degF
= temperature of flue gas leaving the catalyst bed, degF

= condensation temperature, degF

= inlet temperature of coolant, degF

= outlet temperature of coolant, degF

= emission stream temperature, degF

= temperature of saturated emission stream, degF

= flare gas temperature, degF

= emission stream temperature after heat exchanger, degF
= reference temperature, = 70 degF

= inlet steam temperature, degF

= condensed steam outlet temperature, degF

= inlet cooling water temperature, degF

= outlet cooling water temperature, degF

= logarithmic mean temperature difference, degF

= P e N Ea
E—iﬁ-—ls ola

—

A .—ii
°

o B e B
8

=F
£

= absorber column thickness, ft

= overall heat transfer coefficient, Btu/hr-ft2-degF

= drift velocity of particles, ft/sec

= velocity of gas stream in the duct, ft/min

= emission stream velocity through carbon bed, ft/min
= throat velocity of saturated emission stream, ft/sec

cccgcc g
n £
]

(]
-
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Uy, = flare gas exit velocity, ft/sec

U... = maximum flare gas velocity, ft/sec
Ut = annual utility costs, $/yr

\Y = combustion chamber volume, ft3

0

\Z = volume of carbon bed, fi’

\/ = catalyst bed requirement, fi3

V peciung = absorber column packing volume, ft3

w = particle grain loading, gr/acf

Wi = absorber column weight, 1b

X = mole fraction of solute in solvent, moles solute/(moles solute + moles solvent)
X = mole fraction of gaseous component in liquid, moles solute/moles solvent
y = mole fraction of solute in air, moles solute/(moles solute + moles air)
Y = packing constant

Y = mole fracuon of solute in air, moles solute/moles air

y = carbon bed depth, ft

€ = packing constant

A = latent heat of vaporization for steam, Btu/lb

n = fan efficiency, %

Pred = density of carbon bed, Ib/f3

Pe = density of carbon steel plate, 1b/ft3

PG = density of gas (emission stream), 1b/ft3

oL = density of solvent, 1b/ft3

6,45 = cycle time for adsorption, hr

Oreg = cycle time for regeneration, hr

Bdry-cool = cycle time for drying and cooling the bed, hr

17y = viscosity of solvent, centipoise

M = viscosity of solvent, Ib/ft-hr
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APPENDIX D - ABBREVIATIONS AND CONVERSION FACTORS

EPA policy is to express all measurements used in Agency documents in metric units. Listed below are the

International System of Units (SI) abbreviations and conversion factors.

To convert from To Multiply by
Cubic meter (m3) Barrel (oil) (bbl) 6.290

Cubic meter (m3) Cubic feet (ft) 3.531 X 10!
Cubic meter (m3) Gallon (U.S. liquid) (gal) 2.643 X 102
Cubic meter/second (m3/s)  Gallon (U.S. liquid)/min (gpm) 1.585 X 104
Degree Celsius (degC) Degree Fahrenheit (degF) (degC X 9/5) + 32
Joule () British thermal unit (Btu) 9.480 X 104
Joule (J) Watt-hour (Wh) 2.778 X 104
Kilogram (kg) Pound-mass (Ib) 2.205

Meter (m) Feet (ft) 3.28

Meter (m) Inch (in.) 3.937 X 10!
Pascal (Pa) Atmosphere (760 mmHg) 9.870 X 10-6
Pascal (Pa) Pound-force/inch? (psi) 1.450 X 104
Watt (W) Horsepower (electric) (hp) 1.340 X 103

Standard Conditions

68 degF = 20 degC

1 atmosphere = 101,325 Pascals
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